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The following changes have been made to DAT/EM products between Release 6.5 and Release 6.6. Please review these 
revisions made to the software and update your software to implement changes. 
 
As always, DAT/EM welcomes comments and suggestions from you, our clients, so please don’t hesitate to contact our 
support department at support@datem.com, or by calling in or faxing us with your requests. 
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Operating Systems 
Release 6.6 is supported on Windows XP Professional and Windows 7 Ultimate or Professional operating systems. 
Testing no longer occurs for Windows 2000 or VISTA Ultimate. If you have a question, please contact Support. 

CAD Versions 
Release 6.6 has interfaces to the following 32-bit and 64-bit CAD versions: 

 AutoCAD: Autodesk 2004, 2005, 2006, 2007, 2008, 2009, 2010, 2011, 2012, and 2013 products. This is the first version to 
support AutoCAD 2013. DAT/EM software will install for multiple AutoCAD products of different year numbers on the same 
computer; however, it will not install for multiple same-year versions together. For example, it will not install for both 2012 and 
Map3D 2012.  
BE ADVISED: Version 6.6 no longer supports AutoCAD 2000-2002 versions. If you use these old AutoCAD versions, please 
upgrade to AutoCAD 2004 or higher. AutoCAD version 2007 or higher is needed in order to use the new MAPEDITOR. 
 

 ArcGIS: ArcMap 9.1, 9.2, 9.3 (service pack 1), 9.3.1(service pack 2) and 10.0 (service pack 4) 
 

 MicroStation: MicroStation V8 and V8 2004 Edition, XM, V8i Select Series 1 and 2, and Bentley Map Select Series 1 and 2 
are approved. Select Series 2 is recommended over Series 1. 

o Note for Select Series 1-to-2 upgrades: If you upgrade to MicroStation or Bentley Map from Select Series 1 to 
Select Series 2, you must reinstall any DAT/EM software after installing Select Series 2. 

o DO NOT USE SELECT SERIES 3: DAT/EM software does not install for Series 3. 
 

Hardware Locks/Dongles 
Please install Microsoft Updates and Service Packs for your operating system before applying lock reset programs. 
Network licensing should have the same Sentinel driver version on both the server and the local computers running the 
software. 
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Summit Evolution 
The following changes have been made to Summit Evolution and the applications that are provided with it. 

1. There is a new Groups tab on the Project window for all stereo project types. Groups are subsets of the models 
in a project. They allow you to define groups of models so that the Tools>Options>Project>Automatically load 
next model… function will only open models from the same Group. 

 Groups are especially useful when the project contains multiple image sets from different times/sources, 
and you want a view each set in a different viewport. For example, you have imagery from every two 
years; create Groups for 2008, 2010, and 2012 so that each of three viewports can only open models 
from its assigned Group year. 

 Groups can only be used for stereo imagery in the same Summit project file. That is, all the images are 
from the same major image type (such as all aerial), and all have the same input coordinate systems. 

 Alternative: If your image sets must be in different .smtxml projects or can’t contain model definitions, 
please use multiple Summit instances as described in 0 below. Examples of image sets that can’t use 
Groups include: A combination of aerial and RPC satellite imagery (these require separate projects), any 
image sets that have different input coordinate systems (these require separate projects), and Orthophoto 
Collection projects (these are not stereo, so they can’t define models). 

 
To make groups, start with a Summit project that has 
models defined. Select the Groups tab on the Project 
window. 
 

Select the  button, enter a name for the group, and 
select models to add to the group. Either highlight multiple 

models and press the  button or double click a 
single model to move it to the opposite list.  
 
If all the model names to be selected have a similar string 
in their name, such as “6_4” in this example, enter the 
characters in Regular Expression and press the Select 
button to help highlight the models. 
 
Select OK to finish the group. Repeat to build each group. 
 
A model can belong to more than one group. 
 

Use  to edit and  to delete a highlighted group. 
 

To use Groups, open multiple viewports (View > Viewports). From 
the Groups tab, drag a group name or a model from within the group 
into a viewport. The viewport will show the model and group name in 
the viewport title. When this viewport has focus, it will only 
automatically load the next model if the next model is in its group. 
 
A group may be open in more than one viewport.  
 
As always, non-group models may be opened at any time in any 
viewport by opening the model from the Models or Images tabs. 
Opening a model from the Models or Images tab cancels any group 
that might have been active in the viewport. 
 
 “Group 2” open in a viewport 

“Add a group from the Groups 
tab on the Project Window 
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2. Multiple instances of Summit have changes and may be used as follows: 

a. Any number of Summit instances can now automatically share the 3D input device. (Previously, only two 
instances could share it.) 

b. The Summit instance that has current Windows focus automatically gains control of the 3D input device. 

c. If a non-Summit application has current Windows focus, the Summit instance that most recently had focus 
retains control of the 3D input device. 

d. The SUMMIT that controls the 3D input device can control the cursor in all the other Summit instances, as 
long as the projects have the same output coordinate system. For example, open an aerial project in one 
instance, and open an RPC satellite project of the same geographic area and the same output coordinate 
system in another instance; one instance can control the cursor position in the other instance. The 
instance that has control of the cursor will move the most smoothly. 

e. Alternative: If there is only one .smtxml project file, it is better to use Groups in one Summit instance 
instead of opening the same project in multiple instances (see Groups in item 1 above). 

 

3. Some imported project types, such as DVP and Socet Set SUP, import interior matrices and do not create camera 
files or fiducials. A .smtxml project that does not have a camera file cannot be imported by Trimble Inpho 
products. For this reason, two methods have been added to create virtual camera files and fiducials that result in 
the same orientation as the interior matrices. Please note: 

 The calculated fiducials will not match up visually with the actual fiducial marks on the image (if there are 
any), just as the virtual camera file is not the same as a camera file created with the actual camera 
calibration report. These are calculated fiducials and calculated camera files that produce the same 
orientation as the previously imported interior matrices. 

 DVP digital camera projects will most likely make only one camera file to be used by all the images, but 
other projects will most likely make a different camera file for each image. 

 The virtual camera file name(s) will match the image file name(s) unless only one camera file needs to be 
made. 

 Notes inside the new camera file(s) will say, “Virtual camera file.” 

The two new methods are as follows: 

a) When importing a DVP PAR files project, there is a new choice to create an interior matrix or fiducials 
and virtual camera files. The Interior matrix choice is the original functionality that imports an interior 
matrix, but does not create a camera file. Make fiducials and camera files is the new setting: 

 



DAT/EM Systems International RELEASE 6.6 Product Notes 

 4

b) For any existing project that has interior matrices without a camera file, select the new menu option, 
File > Convert interior matrix. Supply the input .smtxml project file and a new output project name. 
A new project with fiducials and one or more virtual camera files will be made.  

 

 

4. Summit>Imagery>Project Histogram is a new option to generate histogram files for each image and apply 
histogram matching to the images in the Summit view. 

 

The first part of the dialog lets you generate histogram files. These are binary files that contain the images 
statistics. The file extension is *.histohfa. These files will be placed in the same folder as the image files. Note 
that they are a binary format, so you cannot view them with a text editor. Next to the Process button is a Zoom 
level selection. For most purposes this should be left at 1X. You can generate them at higher levels, but this 
would mostly be for speed. Images that take 2 minutes to process at 1X might take less than two seconds at 8X. 
Once the histogram file is created, there is no need to process them again unless you want to use a different 
zoom level. For example, if you generate them at 8X and then switch to 2X and hit Process, it will generate new 
histograms; however, if you select 16x it will not generate new files, because the current files are already at a 
higher level. Please note that higher levels are better and there is usually no reason to decrease accuracy. 

Note that 1X .histohfa files may also be generated by Image Creator. See item 16.b. on page 12. 
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After generation there will be a button, , for viewing the histograms for each image. For example: 

 

The next half of the dialog deals with Histogram Matching: Off, Match all images to the project histogram, and 
Match stereo pairs. These are project settings. The histogram files are required to use these settings. If the files 
are not there, nothing will happen. With a model open and using the Apply button, the effects for the matching 
can be viewed. Note that if all the images are similar it will be hard to notice the effects. This histogram 
adjustment happens before any other adjustment. The following is an example of this setting: 

Off: Match all images to project histogram: 

Match stereo pairs (this is the average histogram of the two images): 
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5. Contrast Stretch is a new adjustment option on the Imagery>Image Adjustment dialog. Contrast Stretch is a 
linear histogram equalization using the standard deviation locations as the new minimum and maximum. The 
slider bar is the number of standard deviations (StdDevs) from the mean. The range is from 1 to 3 with a default 
of 2 StdDevs. The larger the StdDev, the less effect of the stretch. The histogram is stretched from the number of 
StdDevs to the edges of the histogram. The images that would benefit the most have a histogram distribution 
bunched around the mean. The new distribution would be across the whole histogram. 

 

New Contrast Stretch setting 

 

6. View > Viewports Select 3D SI is a new menu item that allows everyone – including system mouse-only users –  
to toggle the 3D SI-only view in any viewport. The 3D SI-only view was a new option for multiple viewports in 
version 6.5, but could not be set by system-mouse-only users, because it could only be accessed from the right 
click menu in the viewport. The right click menu does not appear if using a system mouse as a SUMMIT digitizer. 
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7. Summit’s Cursor Selection dialog has a new Ground Grid tab to set a grid of lines or points around the cursor 
center. This grid can be clipped to the ground rings (set on the adjacent Ground Rings tab) area or not, and has 
other settings such as angle, color, ground size, and opacity. 

 

The new Ground Grid settings 

   

Examples of different Ground Grid settings results 

 

8. SUMMIT’s File > Export > Export Model Bounds has three 
new Output options: 

 Complete bounds for each model: Draws a polygon 
around each models’ entire stereo area, no matter how 
much it overlaps any other models. 

 Arrange bounds edge to edge per strip only: Draws 
model boundaries that do not overlap the stereo area 
of the adjoining images in the same strip, but may 
overlap stereo model areas from other strips. 

 Full block edge to edge: Draws completely non-
overlapping polygons around stereo areas. In areas of 
multiple-model stereo overlaps, it splits the multiple 
overlap area among the overlapping models. 
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9. Summit’s superimposition  has the following updates: 

a. AutoCAD polyline closing “segments” that have an arc bulge factor now display correctly as arcs in 
superimposition . 

b. Orientation > Show Camera/Kappa Direction is new. It toggles camera direction and kappa angle 
arrows for one or two open images. The setting is off by default and is not a saved setting, so that it is off 
every time Summit starts. The arrows appear at the origin of each open image’s center. For best viewing, 
zoom out so that one or both image centers are in the Main View. 

 

 
Camera direction and kappa angle display for a single open image 

 
Camera direction and kappa angle display for two end-overlapped images from different strips. 

The camera angles are opposite each other, since the airplane was flying different directions for each image. 
The origin for each arrow set is at the image center. Zoom out if this is not currently visible. 
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10. The Camera Editor (Edit > Camera File) has two new Distortion settings: 

Important! The two new camera distortion methods are not backwards compatible with previous versions 
of DAT/EM software. If either of these distortions are present in the camera file, the project must be used 
with DAT/EM software version 6.6 or higher. Older versions will fail if they encounter the new distortions. 
Camera files that do not use either of the new distortions will be backwards compatible. 

a. Distortion > Seven Parameter: This has been added for UAV (Unmanned Aerial Vehicle) projects. 

 

b. Distortion > Radial & [and] Decentering: This is an eight-parameter version that is mostly used when 
importing SUP file distortions. 

 



DAT/EM Systems International RELEASE 6.6 Product Notes 

 10

11. Aerial projects have the following orientation and orientation-related changes: 

a. Scanned images from a single frame film camera at different scan scales are now supported. Previously, 
frame aerial images that were scanned at different micron levels did not produce good stereo. Summit’s 
epipolar adjustment now corrects properly for scan scale. 

b. In previous versions, if an UltraCam camera’s project had no EO (exterior orientation) values, 
Tools>Reports placed “Focal Length = 0” in the report file. Now the focal length is reported correctly. 

c. The Tie Points Relative Orientation dialog has two changes: The Overview button has moved to 
prevent accidental activation; the list of models where a point is found has expanded to show more 
models before the gaining a scroll bar. 

 

 

d. Control Transfer for aerial projects has two methods now. Control Transfer changed in version 6.5 to 
allow more project types and to make it work for single images. The new method does not require a 
relative orientation and does not move in relative mode. However, some users missed the aerial project 
method that was available in version 6.4 and lower, because they liked the relative movement mode and 
seeing the points in the Absolute Orientation dialog. Both methods are available now in 6.6. When 
Orientation>Control Transfer is started in an aerial project with relative orientation, a question appears: 

 

 Yes-Method 1 is the method from version 6.4 and lower that shows the points in the Absolute 
Orientation dialog. This method requires a relative orientation and it moves in relative mode. 

 No-Method 2 is the new method that shows the control points in the Tie Points dialog. A relative 
orientation is not required. It moves in pixel mode. 

 This is completely the user’s choice. The method makes no difference to the resulting orientation. 

Overview button moved 

Longer list 
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12. VisionMap A3 projects have the following changes: 

a. When a VisionMap A3 projects was open, the north arrow display pointed to the negative of the actual 
north angle. For example, if north was 15º, it would point to -15º. This was a display issue only and had no 
effect on the A3 project. 

b. If two A3 images that are not from the same model are opened, Summit will perform an automatic kappa 
rotation for each image separately in the view. This makes it possible to view two images that “don’t go 
together” for possible stereo viewing. If the images overlap the same ground area, there may or may not 
be good stereo in some parts of the overlap. Summit cannot epipolarize A3 imagery, which means that 
any scaling and skew differences are not corrected. This new kappa rotation may be of some limited use 
in some projects. It is always best to open two adjoining flight line images for a “real model”. 

 

VisionMap A3 images that “don’t go together” displayed at their kappas for possible stereo viewing 
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13. Orthophoto Collection projects (Summit projects made of orthophoto images, not for orthophoto creation) have the 
following changes: 

a. Coordinate transformation is now available. Note that this makes orthophotos more useful for use with 
multiple SUMMIT instances that need to control each other’s cursor position, since all such projects need to 
have the same output coordinate system (see item 2 on page 3 above). 

b. The Project Edit dialog now allows you to select multiple orthophoto image files to add to the project. 
Previously, only one image could be selected at a time. 

14. Satellite RPC projects can now use Astrium© Pléiades satellite imagery. Order the Pléiades Level 1A stereo or 
tristereo imagery in either TIF or JPEG2000 format. JPEG2000 may be preferable due to Windows 7 large TIF 
problems. Create the project with Summit’s RPC satellite project type. 

Note that Pléiades imagery is offered in either TIF or JPG2000. Use the Image Creator for either format: 

 Pléiades TIF is not tiled and does not contain image pyramids, so it must be processed with DAT/EM 
Image Creator with a recommended setting of New TIF and PYR. “New TIF” tiles the 1X image and 
“PYR” makes the zoom level pyramids. Microsoft Windows 7 has known problems dealing with large TIF 
files; be sure your original TIFs are not located in the same folder as the “New TIF” destination. Use a 
different destination folder in Image Creator. If the folder is the same, Windows will fail to rename the new 
file “_new” to differentiate it from the old file, and the original file may disappear. Windows 7 can also lock 
up when copying or moving Pleiades TIF files; this is not DAT/EM’s problem, but rather Microsoft’s. 

 Pléiades JPG2000 may be opened as-is, but be aware that JPG2000 is slower to load and tile than TIF. 
DAT/EM strongly recommends processing JPG2000 with the Image Creator set to New TIF and PYR. 

Note that once a Pléiades RPC project is made, it must be used with DAT/EM version 6.6 or higher; it is not 
backwards compatible due to Pléiades’ new RPC file format and new JPG2000 format. 

 

15. Contour Creator has no changes. Please note that Contour Creator can trigger a MicroStation crash when writing 
contours directly into MicroStation V8i Select Series 2. This problem is in DAT/EM Capture for MicroStation, not 
Contour Creator. The problem was identified too late to be completely fixed for version 6.6. If you experience this 
problem, please contact DAT/EM Support and ask to be notified when an update is available. 

  

16. Image Creator has the following changes: 

a. It can now process the new JPEG2000 image format changes as seen in Astrium Pléiades satellite 
imagery. This file format compatibility applies to Image Creator, Summit Evolution, and any other DAT/EM 
product that reads images. 

b. Generate histogram file is a new setting to create 1X-level histogram .histohfa files. These may be 
used in Summit’s new Imagery>Project Histogram tool shown above in item 4 on page 4. 

 

Image Creator’s new Generate Histogram File setting 
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17. Project Viewer / Ortho+Mosaic has the following changes: 

a. Both the straight seam line and optimized seam line generators have been rewritten. They now create 
joined seams, no matter how many image overlaps and kappa angles are present. 

The Generate Seams dialog is simplified to only ask to generate or remove seams: 

 

  

                                                                          New version of dialog for straight line seams 

 

 

This example shows the seams generated for 109 greatly overlapping images with many different flight line angles 
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Project Viewer / Ortho+Mosaic changes, Continued. 

 

 
This example shows the seams generated for a set of traditional left-right/right-left flight lines. 

It is no longer necessary to edit separate seam lines to meet at the higher-overlap-level corners; 
this is done automatically. Edit manually only if you would like the seams to follow a different path. 

 

The Optimized Seam Line generator additionally processes the seams to find the best path through areas of 
most similarity. For example, forests, water, and buildings tend to be dissimilar between orthophotos, so the 
paths tend to avoid these. Roads tend to be similar, so the paths tend to follow them.  

The Optimal Seam Line dialog has a slider with three states. The leftmost setting will generate the fastest, but 
will have result in less defined paths. The rightmost setting will generate the slowest, but will result in better 
defined paths. The middle setting is often the best choice and is always the default. The generator is 
multithreaded and will use up to 5 background threads, depending on the computer. This processes much 
faster than the older version. 

  

                                                                    New version of the dialog for optimized seams 
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Project Viewer / Ortho+Mosaic changes, Continued. 

The only points that are not optimized or moved are the join locations where multiple seam lines meet. The 
join point may not be on an optimal path, but it is the best join location in the overlap area. If desired, view 
each join and manually edit only if necessary. 

 

Example of optimized seam lines generated at the default (middle slider bar) setting 

b. Defined mosaic boundaries that are not positioned over any input orthophoto will be written out as 100% 
background pixel color. Previously, the image would not be created if it didn’t have any image pixel colors 
in it. Now DAT/EM assumes that if the user creates a mosaic boundary, then the image should always be 
created. It is up to the user to use or discard all-backgroud-color images if they are not wanted. 

c. Boundary Grid is a new interactive method to create a grid of named mosaic boundaries: 

 Select the Grid Boundaries icon on the Mosaic toolbar and make settings:   

 

 



DAT/EM Systems International RELEASE 6.6 Product Notes 

 16

Project Viewer / Ortho+Mosaic changes, Continued. 

 

 Either key in exact coordinates or move the grid interactively on screen using the  button. 

 Use the  button to label each grid location. Mosaic files will be named according to these labels. 

 Use the  button to export the grid boundaries to a CAD/GIS file. 

 The new boundary grid will not have a 1-pixel overlap. It is made to use with the overlapped boundary 
processing method, which will always be used automatically. 

 A boundary grid may be combined with any other boundaries, if necessary. 

 If a boundary grid is in use with other boundaries, all boundaries are treated as overlapped regardless 
of the Inclusive/Overlapped setting that is made on the Main tab of the Create Mosaic dialog. 

 If a boundary grid is not active, then any other boundaries may use either Inclusive or Overlapped 
on the Main tab of the Create Mosaic dialog. (Note that these settings were added in version 6.5. Use 
the context-sensitive “?” dialog help for information on these settings.) 

 

d. Mosaic boundary names keyed in to the Mosaic Image Boundaries dialog were not being saved. The 
names would be blank the next time the dialog was viewed, and the names would not be used to name 
the output files. This has been fixed. 

 

“Name” column contents now saved correctly 

 

  

Landscape 
The following changes were made to Landscape: 

1. A problem was fixed for running the Key Points filter twice with the same filter settings on the same file. 
Previously, this could remove all the points. 
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DAT/EM Capture for ArcGIS 
The following changes were made to DAT/EM Capture for ArcGIS: 

 Compatible with 32-bit versions of ArcGIS 9.1, 9.2, 9.3.1, and 10.0 (each with the latest service packs installed) 

1. It is now possible to set a field value from the DAT/EM Keypad, other touch device, or digitizer button. Syntax: 

SetFieldValue Layername:FieldName:value 

For example, 

SetFieldValue Obstacle:Description:Building. 

Fields and values that contain spaces must be grouped with quotes, for example: 

SetFieldValue Obstacle: "Description field with spaces":"Multiplex residential". 

It supports using the field alias instead of the field name. For example, SetFieldValue Obstacle:"Alias of 
Description Field":"Single family home" where “Alias of Description Field” is the field alias.  

2. CutPolygonTask is a new keyword to use on the DAT/EM Keypad, other touch device, or digitizer button. It is the 
same as setting the task to Cut Polygon Features on the ArcMap 9.x Editor toolbar or setting Cut from the 
ArcMap 10.x DAT/EM Capture Drawing Tools toolbar. Suggestion: Add Draw Arc, Draw PointToPoint, or Draw 
Square to CutPolygonTask to activate both polygon cutting and a DAT/EM drawing tool. 

3. Use DAT/EM tools to clip with interpolated Z is a new variation on the previously existing DAT/EM clip tool. 
Both tools clip interior rings into polygons. The method used to draw the interior ring is the same as for the older 
clip tool. Both of these tools are located on the DAT/EM Capture Drawing Tools toolbar. 

 The older clip tool, , draws the interior ring at the stereoplotter elevation. This has not changed. 

 The new “interpolated Z” version, , matches the Z of each vertex of the interior ring to the Z 
interpolated at the closest location on the exterior ring. 

4. In previous versions, if the cursor got within snapping distance of a true circle object (not a DAT/EM-drawn 
segmented “circle”), an error message would appear for every possible snap position. The user would was 
required to “OK” each message. This message has been removed. 

5. Verify elevations decreasing and Verify elevations increasing are two new monotonicity settings that work 
together with DAT/EM drawing tools. When on with a drawing tool, they check the previously digitized elevation 
and do not allow lower (for Verify elevations increasing) or higher (for Verify elevations decreasing) 
elevations to be digitized. These are found on the DAT/EM Capture Drawing Tools toolbar: 

 

 

Along with these monotonicity settings are two new keywords, MonoDown and MonoUp, to activate them from 
the DAT/EM KEYPAD, other touch device, or digitizer button. MonoDown turns on the Verify elevations 
decreasing option. MonoUp turns on the Verify elevations increasing option. 
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6. DAT/EM’s version of Cut Polygon (Cut Polygon with a DAT/EM drawing tool) has several improvements: 

a. The DAT/EM Draw Stream tool has been activated for use drawing the cut line. Draw Stream may be 
used exclusively or toggled to/from other active DAT/EM drawing tools. 

b. The Trace Multiple drawing tool is automatically deactivated if the task is set to Cut Polygon Features 
(9.x) or Cut (10.x). Trace Multiple is not compatible with cutting polygons. 

c. Undo now works to undo segments or arcs from the cutting edge while it is being drawn. 

d. Undo used after cutting a polygon successfully reverts back to the polygon’s original state. 

e. Cut Polygon no longer crashes when using the DAT/EM arc drawing tool to draw the cutting edge. 

f. CutPolygonTask is a new keyword to use on the DAT/EM KEYPAD, other touch device, or digitizer button. 
See 2 on page 17 above for more details. 

 

7. The Clip Polyline tool can now cut a polyline into two separate, end-snapped polylines. To do this, pick twice in 
the same location. Note that the tool still has its original two functions as well: Clip off the shorter end of the 
polyline and clip into two polylines separated by a gap. 

 

Activate Clip Polyline and pick twice in the same location 

 

The result is two end-snapped polylines 

 

 

8. Some redraws after edits, such as after using Field Update, would draw the edited object at Z=0 in SUMMIT’s 
superimposition (SI). A further SI Update would redraw it at the correct elevation. This has been fixed to draw the 
object at the correct elevation immediately after the edit. 
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9. There is a new Zoom with Summit checkbox in the DAT/EM Capture coordinates dialog. 

 Zoom with Summit checked on (previous functionality), the ArcMap view zooms in and out when SUMMIT 
zooms in and out, with a relative scale set by the slider in the DAT/EM Capture dialog. 

 

 

 Zoom with Summit unchecked (new functionality), the ArcMap view does not change scale when SUMMIT 
zooms; it stays at the scale set on the Standard toolbar. 

 

Note that the ArcMap view always pans with SUMMIT, no matter how Zoom with Summit is set. 
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10. Airfield3D has the following updates: 

a. There is a new Airfield Slope dialog that allows you to change the slope of the Left and right VGPS and 
VGAS surfaces or reset them the to the 18B defaults. Several customers requested differently sloped 
surfaces in these areas to temporarily work with non-18B specifications. Start Airfield3D on the ArcMap 

side. Select the  Airfield Slope button from the lower edge of the dialog. Select one or more runways 
from the Runway list. Set the desired slope from the Slope list for the particular surfaces below. Either 
select a value from the menu or key in a new value. Select Apply to activate the different slope settings. 
All surfaces for all runways will be recalculated and redrawn. In Summit’s superimposition, all runways will 
be reset to checked on and all OEIs (One Engine Inoperable) surfaces will be unchecked. You may then 
check and uncheck any surfaces using the Airfields dialog in Summit. 

To reset the values to the 18B defaults, select the reset button, . 

 

b. The SetFieldValue option mentioned in item 1 on page 17 above may be especially useful for Airfield3D 
tasks.  

c. The Natural and Manmade settings have been removed from the Airfield3D – Field Update dialog. 
These settings made the user decide whether or not to measure the height of the objects for the “Above 
Ground Level” field. Measuring the height of an object is necessary for manmade features only. Now this 
is determined automatically when the “Obstacle Type” field is set. 

d. Airfield3D has a new status tracking tool called Measure Status. Use it to quickly see whether enough 
points have been digitized within each surface area. Points on the Obstacle layer are counted and 
displayed, and the areas are color coded as follows: 

 Red dot: No points in area. 

 Yellow dot: At least one point, but not enough points, in area. 

 Green dot: Enough points to meet the 18B standards for the area. 

To use the Measure Status tool, select the stoplight-like button on the Airfield3D - Field Update dialog: 
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The Airfield Measure Status dialog appears. Get information and/or move the cursor as described in the 
graphics below: 

When the list is expanded, information about individual surfaces is visible: 
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DAT/EM CAPTURE and MAPEDITOR for AutoCAD 
Changes apply to: 

32-bit AutoCAD 2004-2013 versions with the latest service packs. 

64-bit AutoCAD 2008-2013 versions with the latest service packs. 

BE ADVISED: Version 6.6 no longer supports AutoCAD 2000-2002 versions. If you use these old AutoCAD versions, please 
upgrade to AutoCAD 2004 or higher before installing DAT/EM version 6.6. 

DAT/EM software will install for multiple AutoCAD products of different year numbers on the same computer; however, it will not 
install for multiple same-year versions together. For example, it will install for AutoCAD 2011 and AutoCAD Map3D 2012 together, 
but it will not install for both AutoCAD 2012 and AutoCAD Map3D 2012. 

Reminder: You must run AutoCAD at least one time to activate its license before installing DAT/EM software. 

The following changes were made to DAT/EM Capture and MapEditor for AutoCAD: 

1. Version 6.6 is the first version to be compatible with AutoCAD 2013. 

2. DATDRAW has the following changes: 

a. DATDRAW’s rubber banding was causing Summit Evolution’s superimposition to be slow. Since 
superimposition has its own rubberbanding, DATDRAW’s rubberbanding has been removed. 

b. During stream digitizing mode, key in “N” or “n” to activate a “pen up” mode. The polyline will still be in 
process, but no points will be added to the line until the digitizing button is pressed again to resume the 
“pen down” mode. 

3. The stand-alone CROSSCHECK command (as well as the version in MapEditor) has performance improvements. 
One example file that contained many polylines previously processed in 7 hours and now takes 20 minutes. 
Please be aware that the time it takes to process polyline crossings is exponential based on the total number of 
polyline segments. Please plan to allow enough time for the process to run. 

4. The stand-alone GRIDIT command could insert the wrong block due to incorrectly alphabetizing the block list. 
This has been fixed so that the selected block name is the block that is inserted. 

5. AUTOLIST no longer causes AutoCAD to crash if the application is loaded, unloaded, and loaded again. 

6. AutoCAD polyline closing “segments” that have an arc bulge factor now display correctly as arcs in SUMMIT’s 
superimposition. 

7. DTMIT has improvements: 

a. Previously, when a point was skipped, the stereoplotter would move to the correct (x,y), but an incorrect 
elevation for the next point; now the elevation does not change during the skip. 

b. When both Show grid and Alternating drive direction were on, Collect could start at the last point of 
the first row, skipping any previous points in the first row. Now Collect always starts on the first point of 
the first row. 

c. If Osnap was on during DTMIT data collection, it would give unreliable results. Now DTMIT saves the 
previous Osnap state, turns Osnap off during data collection, and restores the original Osnap setting 
when finished. 

d. It could show all the same IDs for individually selected objects on the Select tab. This was a display-only 
problem; the proper IDs were used internally. The display has been fixed. 

e. If Define Sample Points (also known as “Sparse Points”) is on with Free Movement on and Drive To 
Ground off, only one digitized point is necessary to insert each data point. Note that for all other settings 
combinations, two digitized points per data point are still necessary. 
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8. MapEditor for AutoCAD has the following changes: 

MapEditor Operational Changes: 

a. Some AutoCAD commands such as PAN can interfere with MapEditor’s selection tools. Only one 
command that requires a selection should run at a time. If a command such as PAN is active when a 
MapEditor selection tool is started, a message now appears: 

 
A message appears if an AutoCAD command such as PAN is 

running when a MapEditor selection tool is started 

If this message is received, select OK, cancel the current AutoCAD command, and try again. 

b. Some select-layer-from-object controls were visible on the dialog, but not operational. These have been 
activated. 

c. AutoCAD could sometimes give multiple “!” error messages or a loud double beep sound as it closed after 
having had the MapEditor loaded. This was annoying to the user, but did not have any lasting bad effects. 
These messages and sounds have been eliminated. 

 

MAPEDITOR New Tools: 

d. Spot Interpolation is a new tool to interactively insert spot elevations based on the elevations of nearby 
existing objects. This tool runs interactively only; it cannot be added to a batch file. Set “Interpolation 
Objects” to define the existing objects that will provide the elevation data, for example, breaklines and 
elevation contours. Choose “Nearest Neighbor…” to determine the elevation based only on the single 
closest possible point in the input set. Set “Use interpolation objects within search range” to determine 
the elevation based on all input objects within the “Radius”. Make settings for the text and mark 
appearance. Select the green Run button. Click once in the AutoCAD view to activate a circle around the 
cursor. Objects that fall within this circle will be used as interpolation objects. Follow the prompts to select 
locations for new spot elevations. When finished, key in a blank return or <Esc> to return to the dialog. 

 

    

Example of Spot Interpolation selections  
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e. Volume Calculation is a new tool to calculate volumes based on an upper surface and base elevation 
definition. Create a base definition and a surface definition. The definitions may either be objects in the 
drawing file, a DTM/DEM in a file, or both. If running more than one distinct area at one time (for example, 
two gravel piles drawn with polylines), place any base and surface definition objects on separate layers. 
The Base Selection has a Densify factor setting for drawing objects; this setting interpolates points at 
the set ground distance along polyline vectors, so that long segments are treated as having more 
vertices. The results are expressed in cubic ground units. 

 

New MapEditor Volume Calculation tool 
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MapEditor Existing Tools: 

f. In rare cases, Cleanup’s zero-length polyline check could remove polylines that had a non-zero length. 
This has been fixed. 

g. Clip Object now clips splines and lines in addition to polylines. 

h. CrossCheck has the following changes: 

o CrossCheck will now make a new layer from a keyin in the Insert text > Layer field. Previously, it 
would not make the new layer, and after running, the text would be on layer 0. 

o CrossCheck has a new option to find intersections inside or outside one or more closed polyline 
boundaries. If the setting is not checked, the whole file will be searched. To use boundaries, check on 
Use boundaries and use the arrow button to activate the settings dialog. Both the boundary settings 
and the previously existing marking/reporting options have been moved to separate settings dialogs. 

o CrossCheck has performance improvements. One example file that contained many polylines 
previously processed in 7 hours and now takes 20 minutes. Please be aware that the time it takes to 
process polyline crossings is exponential based on the total number of polyline segments. Please 
plan to allow enough time for the process to run. 

o CrossCheck uses an Autodesk ARX function that should not project the end of the polyline, but 
unfortunately, it projects the line in some cases. This could lead to false “intersections” being 
indicated a certain small distance away from the end of a polyline, where the polyline actually falls 
short of another polyline instead of intersecting it. CrossCheck now additionally checks that there is 
an actual intersection at the location. This could increase the processing time, but will also increase 
the accuracy of the results. 

o CrossCheck has a new “near intersection” option to mark polylines that are within a distance 
tolerance of each other. In the case that two input lines are parallel and within the “near” x-y search 
distance, there are an infinite number of near intersections; therefore, the algorithm is restricted as 
follows: The algorithm finds near intersections at each “from” and “to” line vertex. At each vertex, 
intersections are determined by intersecting a circle centered at the vertex with other input polylines. 
The radius of the circle is the x-y tolerance. The marking label is centered on the “from” vertex where 
the search was conducted. The corresponding “to” marking label is centered at the closest point that 
the search circle intersected the “to” polyline or, if there are vertices between the two intersections, 
the intersection point or vertex that is closest to the circle center. (The closest distance is relative to 
the “from” vertex.) There is an option to draw a line that connects the near intersections. 

 

Example of “Near intersections”. Green lines are from the “Add line” marking option. 

 

i. XYZOUT previously ignored the Y and Z Decimal precision settings and used the X Decimal precision 
setting for all coordinates. This has been fixed so that the Y and Z Decimal precision settings are 
applied correctly. 
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j. Join has a new checkbox to allow older 2D polylines to be converted to LW polylines. This enables the 
2D polylines to be joined to LW polylines. If the setting is not on, 2D polylines will not join to LW polylines. 

 

Join’s new “Convert 2D polylines to LW polylines” setting 

k. TOUCH has new output file options to write “touched” and “untouched” coordinates to two separate Visit 
files. “Untouched” coordinates are polyline endpoints that were checked for touching, but did not find 
anything to touch within the Search radius. 

 

New TOUCH file output options: “Visit un-touched…” and “Visit touched…” 
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DAT/EM Capture and MapEditor for MicroStation 
Changes apply to Capture for MicroStation V8/2004 Edition, MicroStation XM, and MicroStation V8i Series 1 or 2 on 32-bit and 
64-bit operating systems. Note: 

 MicroStation V8 and V8 2004 Edition: Version should be 08.05.00.34 or higher. 

 MicroStation XM and V8i Series 1: XM version should be 08.09.04.88 or higher. 

 MicroStation V8i, V8i-based Bentley Map and Map Enterprise Select Series 1 and 2: Select Series 2 is recommended 
over Series 1. 

o  If you upgrade from Select Series 1 to 2, you must reinstall DAT/EM software after installing Select Series 2.  
o DO NOT USE SELECT SERIES 3: DAT/EM software does not install for Select Series 3. Development for this 

version is ongoing. 

The following changes were made to DAT/EM Capture and MapEditor for MicroStation: 

1. CLIP’s exterior mode in MicroStation V8i SS2 now handles shared cells correctly. 

2. ELEVATE (Drape) can now use points as input. 

3. EZEDIT has two new Whole Element options: Flip rotates the selected object 180 degrees around its center. 
Rotate rotates the selected object to the set number of degrees. 

  

EZEDIT with a cell to rotate 

  

After EZEDIT > Whole Element > Flip and Rotate 
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4. The ZLABEL family of commands has the following changes: 

a. ZLABEL’s router dialog now closes automatically after an option is selected from it. 

b. ZLABEL GUIDERS now always aligns the text upright in the direction of the guider, but at the same time 
aligned to the polyline it is labeling. Please draw all guiders in the direction of upright text. 

c. The ZLABEL SETTINGS dialog’s "Align Text Labels to Guider" has changed to "Align to labeled object". 

d. ZLABEL PICK now activates a two-pick placement option. The first pick is the center of the text and the 
second pick defines the text angle. This allows the user to decide the final text angle in places where 
“most north” or aligned to the polyline doesn’t give the desired angle.  

 

5. XYZOUT can now export tag values. The existing Tag Data field has been renamed Tag Data (Spec) 
[specification] to clarify that it is the tag data specification name, not the value in the tag. The new fields are 
called Tag Value and Tag Value 2. Tag Value will always return the value of the element’s first tag.  Tag Value 2 
will always return the value of the element’s last tag. Tag field data types of Double, Char, and Long are 
supported. 

  

XYZOUT’s renamed Tag Data (Spec) field 
and the new Tag Value and Tag Value 2 fields 

 

 

Example of XYZOUT results with Tag Data (Spec), Tag Value, and Tag Value 2 fields 

 

6. In the Parameter File Editor, the Pattern Settings dialog now starts correctly when Unpattern (pattern) is 
selected. 

7. The “Pick Classes” list previously allowed duplicate class specifications. It now filters out duplicates from the list. 
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8. The PSQR Object dialog is activated by adding PSQR to a parameter file or by selecting PSQR Object from the 
MapEditor “Run Single Commands” menu. This dialog’s 2D setting previously had no effect. This has been fixed 
so that 2D on and off have the originally intended effects: 

 If 2D is checked on, each vertex in the building element will be set to the elevation of the first digitized 
vertex. 

 If 2D is off, each vertex in the building will retain its current elevation as long as the elevation has 
changed more than Z Tol(erance) from the elevation of the previous vertex. 

 

9. PSQR OBJECT and MEPSQR have the following items fixed or changed: 

a. They could sometimes unsquare an element that already had square (90 degree) corners. This has been 
fixed so that it will pass an already squared element through without changes. 

b. PSQR ELM and PSQR OBJECT did not handle duplicate points correctly. They now eliminate duplicate 
points correctly from the final result. 

c. PSQR OBJECT was losing the last vertex on snapped and closed elements when the closed button was 
unchecked. This has been fixed. 

d. For open, unsnapped objects, PSQR OBJ and PSQR ELM were adding an extra vertex that was far from 
the object. In addition, PSQR ELM was attempting to join the start and end vertices, which moved both 
vertices far from the object. 

e. PSQR OBJECT was using the shape checkbox as the only criteria for whether the new element was a 
shape.  For example, shapes would be converted to line strings by PQSR if the box was not checked. 
Now, if the box is checked, all elements are converted to shapes. If it is not checked, the element 
preserves its type (shapes remain shapes, unclosed elements remain unclosed). This is consistent with 
the way PSQR ELM preserves element type. 

Note: the PSQR tolerance can be adjusted (down) to avoid squaring stroked arcs.  Because there was a work 
around in the current infrastructure, no modifications were made in this area. 

 

10. DAT/EM Contour  Creator can trigger a MicroStation crash when writing contours directly into MicroStation V8i 
Select Series 2 and 3. This problem is in DAT/EM Capture for MicroStation, not Contour Creator. This problem 
was identified too late to be completely fixed for version 6.6. If you experience this problem, please contact 
DAT/EM Support and ask to be notified when it is fixed. 
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11. BETA VERSION: Volume and Volume Text Settings are two new commands in the Parameter File Editor 
command list. These are beta versions. If desired, try this command and give DAT/EM feedback on operation and 
requests. Prepare files or objects that define the base ground level. To calculate the areas of multiple distinct 
areas (such as multiple gravel piles), place each area’s elevation-defining objects on unique levels/attributes. First 
add the Volume Text Settings command to the parameter file. Next add one or more Volume commands. The 
text settings line should always appear before any volume lines in the parameter file. 

  

 

 

 

 


